
СОЗДАНИЕ И 
ПОДКЛЮЧЕНИЕ 
STEP-МОДЕЛЕЙ



⦿ Начиная с версии  Summer 08, в программе  
Altium Designer осуществляется 
взаимодействие с данными MCAD систем на 
высоком уровне. Это позволяет 
импортировать, редактировать и проверять 
сопряжённость с механическими деталями в 
проекте платы. Файлы данных MCAD могут 
иметь связь с реальными файлами для 
обновления информации о деталях в Altium 
Designer.



⦿ Ранее установка механических деталей в 
проекты печатных плат средствами 
«электронных» САПР (ECAD) и их 
последующий импорт в MCAD являлись 
сложным, многоэтапным процессом. В пакете 
Altium Designer имеется целая группа команд, 
позволяющая добавлять детали на плату и 
размещать их согласно техническим 
требованиям. Это даёт возможность не только 
установить на плату такие детали, как 
радиаторы, втулки, подставки и т.д., но 
также закрепить плату в корпусе и добавить 
другую плату с компонентами.



⦿ В качестве формата взаимодействия MCAD и 
Altium Designer используется формат STEP, 
являющийся стандартом обмена 
механическими моделями. Деталь с 
геометрией любой сложности в формате 
STEP может быть сформирована в любой из 
программ твердотельного моделирования 
(SolidWorks, ProE, Компас и т.д.) Формат STEP 
применяется большинством разработчиков 
электронных компонентов, которые 
предоставляют в нём модели корпусов 
полупроводниковых приборов. Пакет  Altium 
Designer поддерживает оба формата STEP 
(AP203 и AP214), однако следует помнить, 
что в формате STEP AP203 не сохраняется 
информация о цвете модели.



⦿ Пакет  Altium Designer позволяет вести 
работу с моделями в формате STEP двумя 
способами. Во-первых можно просто 
добавить деталь на плату; во-вторых, можно 
создать ссылку на файл модели. Ссылка на 
файл предполагает наличие «горячей» связи 
между приложением и исходным файлом 
модели. При создании такой ссылки и 
последующим изменением исходной модели 
STEP в основной программе, Altium Designer 
автоматически определяет изменения и 
предлагает внести их в модель на плате. Для 
использования ссылок на файлы моделей 
должны быть указаны некоторые папки, 
которые Altium Designer будет постоянно 
проверять на наличие обновлений. 
Рассмотрим инструментарий для работы с 
механическими деталями в редакторе плат  
Altium Designer на конкретных примерах.



⦿Пример сборки корпуса и 
сопряжения его с 
печатной платой



⦿ Создадим ссылки на две готовые модели 
STEP, составляющие сборку корпуса 
устройства, в котором будет использоваться 
плата. Сопоставив детали корпуса с платой, 
выполним проверку сопряжённости деталей и 
отредактируем размещение компонентов с 
учётом механических частей. В примере 
будет использован проект  
multivibrator_step.pcbdoc, который находится 
в папке  Altium 
Designer/Examples/Tutorials/multivibrator_ste
p; там же находятся необходимые для работы 
модели в формате STEP.



⦿ Перед использованием моделей в формате 
STEP необходимо указать ссылку на папку, в 
которой хранятся необходимые модели. Для 
этого выполним следующие действия:

⦿ ● откроем окно настроек DXP > Preferences > 
PCB Editor > Models;

⦿ ● нажмём кнопку в области  Model Search 
Path, укажем папку, содержащую модели 
(Altium 
Designer/Examples/Tutorials/multivibrator_ste
p), и нажмём ОК. Если папка с моделями 
находится в папке текущего проекта, то 
достаточно указать относительное 
расположение;

⦿ ● после выбора папки с моделями нажмём 
кнопку Add, и модель добавится в текущий 
список;

⦿ ● нажмём кнопку  ОК в диалоговом окне 
Preferences.



⦿ После указания местонахождения моделей 
можно приступить к размещению моделей 
STEP или ссылок на них в документе платы. 
Для дальнейшей работы откроем документ 
платы, к которой будут добавлены детали 
корпуса:

⦿ ● откроем плату multivibrator_step.pcbdoc 
(File > Open), расположенную в папке Altium 
Designer/Examples/Tutorials/multivibrator_ste
p;

⦿ ● выполним команду Place > 3D Body, при 
этом откроется диалог 3D Body. Для создания 
ссылки на 3D модель, необходимо выбрать 
Generic STEP Model в области  3D Model Type и 
нажать кнопку Link to Step Model. Появляется 
окно, в котором представлен список всех 
моделей, находящихся в подключенных 
папках. Примечание: 3D модели можно 
размещать как в двумерном, так и в 
трёхмерном режиме (переключение режимов 
осуществляется клавишами 2 (2D) и 3 (3D);



⦿ ● выберем файл multivibrator_base.step и 
нажмём ОК в обоих окнах. Модель 
«привязывается» к курсору; для её 
размещения необходимо нажать ЛКМ в любом 
месте рабочей области. Теперь на плате 
имеется обновляемая модель со ссылкой на 
исходный файл;

⦿ ● после размещения первой модели на 
экране снова появляется диалог 3D Body, где 
предлагается установить следующую модель. 
Нажмём кнопку  Link to Step Model, в списке 
выберем модель  multivibrator_cover.step и 
разместим её аналогичным образом;

⦿ ● после размещения обеих моделей 
нажимаем кнопку Cancel в диалоге 3D Body 
для выхода из режима размещения.



⦿ Если размещение происходило в обычном 
(двумерном) режиме, то на экране показаны 
прямоугольники, нарисованные на слое 
Mechanical1. Чтобы просмотреть результат 
размещения деталей, переключимся в 
трёхмерный режим нажатием клавиши 3. 
Если на экране не отображаются трёхмерные 
детали, значит, их просмотр отключен. Для 
включения отображения STEP деталей и 
других трёхмерных объектов необходимо 
(находясь в режиме 3D!) включить оба 
параметра в разделе  3D Bodies (см. рис. 1) в 
настройках  Design > Board Layers and Colors 
(клавиша L).





⦿ В результате на экране, кроме платы, будут 
показаны две модели деталей корпуса. 
Теперь необходимо разместить эти детали 
относительно платы так, как они будут 
выглядеть в сборке. Для выравнивания 
импортированных деталей в пакете  Altium 
Designer используются грани модели или 
контрольные точки (заданные 
пользователем). Кроме этого, имеется 
возможность вращать модель в любой 
плоскости и указывать высоту расположения 
детали относительно платы. В 
рассматриваемом примере модели 
расположены в рабочей области случайным 
образом и далеко разнесены относительно 
платы, поэтому необходимо выполнить 
выравнивание.



⦿ С этой целью могут быть использованы 
следующие операции:

⦿ ● установка вертикального положения 
модели относительно плоскости платы;

⦿ ● использование одиночной контрольной 
точки для перемещения всей модели;

⦿ ● использование трёх контрольных точек для 
перемещения, выравнивания и вращения 
модели;

⦿ ● использование поверхности платы для 
выравнивания модели относительно платы;

⦿ ● использование элементов управления 
моделью через диалоговое окно свойств 3D 
модели.



⦿ В тех случаях, когда модель детали имеет 
такую же ориентацию, как плата (т.е. 
совпадают направления базовых осей модели 
и платы), для позиционирования может быть 
использована одна точка на модели. В 
рассматриваемом примере модель имеет ту 
же ориентацию, что и плата.

⦿ Если посмотреть на плату и базовые детали 
корпуса, можно заметить на корпусе 
прямоугольный выступ, который должен 
проникать сквозь плату. Однако на плате пока 
отсутствует паз для этого прямоугольного 
выступа – его место необходимо определить. 
Можно измерить в MCAD положение выступа и 
по нему определить положение паза в плате.



⦿ Перед этим следует измерить внутренний 
размер корпуса, чтобы определить, 
поместится ли в него плата:

⦿ ● переключаемся в 3D режим нажатием 
клавиши 3;

⦿ ● выполняем команду Tools  > 3D Body 
Placement  > Measure Distances;

⦿ ● нажатием ЛКМ выделяем нижнюю часть 
корпуса, после чего курсор принимает вид 
трёхмерного голубого прицела, который 
перемещается по привязкам на вершинах 
модели;

⦿ ● чтобы измерить размер внутренней части 
корпуса, необходимо выбрать две точки, как 
показано на рисунке 2, и затем измерить 
ширину и длину. Примечание: из-за базовой 
дюймовой системы координат размеры могут 
быть отображены с погрешностью 0,00001 
мм;

⦿ ● аналогично можно измерить диагональ 
внутренней части, при этом будут показаны и 
внутренние размеры; после завершения 
измерения следует нажать ПКМ.



ИЗМЕРЕНИЕ ВНУТРЕННИХ РАЗМЕРОВ



⦿ Теперь, чтобы определить, поместится ли 
плата в данный корпус, измерим параметры 
самой платы, в том числе её линейные 
размеры, для чего выполним Reports > Board 
Information.

⦿ Следующим шагом необходимо определить 
базовую точку в центре прямоугольного 
выступа в корпусе для его сопряжения с 
платой. Расположение паза требует наличия 
отверстия в плате и некоторой зоны запрета 
вокруг этого отверстия:

⦿ ● выполним команду Tools > 3D Body 
Placement > Add Snap Points from Vertices (в 
терминологии  Altium Designer Vertices – это 
точки привязки на вершинах детали, Snap 
Points – точки привязки, заданные 
пользователем);



⦿ ● выберем нажатием ЛКМ 
нижнюю деталь корпуса, после 
чего к ней будет привязан 
курсор прицела;

⦿ ● переместим курсор по 
модели и выберем точки 
привязки на каждом из углов 
двух прямоугольных выступов 
(т.е. создадим 
пользовательские привязки). 
Красными стрелками показаны 
вершины большого паза, а 
синими стрелками – вершины 
малого паза. После выбора 
точек нажмём ПКМ или Esc для 
завершения;



⦿ ● кроме уже выбранных точек, для работы 
понадобится ещё одна – центр паза. Для 
установки этой точки снова вызовем режим 
установки точек и выберем деталь;

⦿ ● далее клавишей Space выберем режим  
Midpoint, который создаёт точку привязки 
между двумя указанными точками. Выберем 
две точки по диагонали паза и клавишей Esc 
завершим операцию.



⦿ На следующем этапе поместим точку 
привязки в центре платы в виде контактной 
площадки:

⦿ ● переключимся в двумерный режим и 
проверим, что начало координат находится в 
левом нижнем углу платы. Если это не так, 
отредактируем положение этой точки 
командой Edit > Origin;

⦿ ● выполним команду Place > Pad;
⦿ ● выполним команду  Edit > Jump >New 

Location, которая позволит перейти в 
заданные координаты;

⦿ ● в появившемся окне введём обе 
координаты 25,4 и два раза нажмём клавишу 
Enter. В результате в центре платы будет 
размещено металлизированное отверстие.



⦿ Теперь можно позиционировать нижнюю 
деталь корпуса относительно платы, 
используя одну точку привязки. Для этого не 
обязательно наличие пользовательских точек 
привязки; здесь могут быть автоматические 
точки привязки, которые формируются на 
вершинах модели:

⦿ ● перейдём в трёхмерный режим (клавиша 
3);

⦿ ● выполним команду Tools > 3D Body 
Placement > Position 3D Body;

⦿ ● нажатием ЛКМ выберем модель нижней 
детали корпуса, после чего на ней появится 
курсор прицела;

⦿ ● нажмём клавишу Tab для выбора режима 
точек. Здесь можно использовать для 
сопоставления точки привязки (Vertices) и 
пользовательские точки привязки (Snap 
Point). В данном случае следует выключить 
параметр  Include Vertices;

⦿ ● переместим курсор в центр модели, и ЛКМ 
зафиксируем эту точку;

⦿ ● переместим курсор в центр платы, и ЛКМ 
зафиксируем положение, когда курсор 
совпадёт с центром контактной площадки. В 
результате деталь корпуса будет совмещена с 
платой.



⦿ Примечание: При выборе центра платы 
курсор должен принять зелёный цвет. Это 
означает, что его положение попадает в 
электрическую сетку вокруг контактной 
площадки.

⦿ При описанном позиционировании платы она 
получается подвешенной над корпусом, 
поэтому необходимо совместить плоскость 
нижнего слоя платы с верхней гранью 
широкого паза. Для этого, находясь в 
трёхмерном режиме, двойным щелчком ЛКМ 
заходим в свойства модели нижней детали 
корпуса и в списке  Body Side выбираем 
Bottom Side. При этом корпус расположен 
обратной стороной к плате.



⦿ Совместим плоскость платы с гранью паза, 
для чего выполним следующие действия:

⦿ ● Tools > 3D Body Placement > Set Body Height;
⦿ ● ЛКМ выберем модель нижней детали 

платы, после чего появится курсор прицела;
⦿ ● переместим курсор на один из углов 

широкого паза, чтобы задать грань для 
выравнивания;

⦿ ● в появившемся окне предлагается задать 
расстояние, на которое будет отодвинута 
плата от выбранной грани паза. В нашем 
случае выберем вариант  Board Surface – 
тогда выравнивание будет происходить по 
плоскости платы.



⦿ Итак, позиционирование нижней детали 
корпуса завершено, и в целом оно было 
несложным, поскольку ориентация детали 
совпадала с ориентацией платы. Теперь 
разместим вторую деталь, ориентация 
которой не совпадает с платой.

⦿ Сначала выполним выравнивание детали по 
плоскости платы:

⦿ ● Tools > 3D Body Placement > Align Face with 
Board;

⦿ ● выберем нижнюю деталь корпуса нажатием 
ЛКМ;

⦿ ● курсор мыши «привязывается» к детали; 
при перемещении разные грани ставшей 
прозрачной детали подсвечиваются. 
Необходимо выбрать ту грань, которая будет 
выровнена с плоскостью платы.





⦿ Результатом описанного действия будет 
совпадение плоскости платы и нижней грани 
детали. При этом направления детали и 
платы могут не совпадать, поэтому совместим 
деталь с платой, используя три точки (в 
отличие от предыдущей детали, которая 
сопоставлялась по одной точке). Для этого 
выбираем три точки на плоскости детали и 
затем три точки на плоскости платы, 
направление которых должно совпадать:

⦿ ● Tools > 3D Body Placement > Orient and 
Position 3D Body;

⦿ ● выберем нижнюю деталь корпуса нажатием 
ЛКМ, после чего курсор примет вид прицела в 
виде большого перекрестия голубого цвета, и 
укажем три точки на детали;

⦿ ● курсором синего цвета укажем углы платы, 
соответствующие направлению ранее 
выбранных точек детали (при наведении на 
угол платы прицел становится зелёным, что 
говорит о попадании в зону вершины платы; 
если этого не происходит, рекомендуется 
увеличить шаг сетки  Electrical Grid);

⦿ ● после выбора трёх вершин платы 
происходит сопоставление направления 
выбранных точек, что обеспечивает 
необходимое положение детали.



После размещения всех деталей видно, что разъём Y1 не попадает в 
расположение окна, и необходимо либо поменять расположение окна 
в детали, либо переместить разъём на плате. В данном случае 
необходимо переместить разъём непосредственно в режиме 3D, 
захватив его ЛКМ. Однако более точно позиционировать разъём можно 
в 2D режиме, но для этого необходимо в режиме 3D установить 
пользовательские точки привязки, которые будут отображаться в 
режиме 2D



Для управления отображением 
деталей в трёхмерном режиме удобно 
воспользоваться панелью PCB, 
которая является аналогом панели 
Design Manager в P-CAD, но, в отличие 
от последней, позволяет вести работу 
не только с цепями и компонентами, 
но и с остальными объектами, 
присутствующими на плате. После 
запуска панели PCB выбираем работу 
с 3D моделями (см. 1 на рис). Теперь 
в панели перечислены все модели, 
которые добавлены на плате (см. 3 
рис), и здесь же можно управлять 
прозрачностью той или иной модели.



К моделям можно применить 
стандартные команды: выделение, 
маскировку и масштабирование (см. 
2 на рис). Ниже дублируются 
параметры отображения моделей на 
плате (см. 4 на рис). Если в панели  
PCB выполнить двойной щелчок ЛКМ 
на названии модели, то откроется 
окно свойств этой модели, где 
можно управлять базовыми 
параметрами расположения модели 
в пространстве относительно платы 
(повороты по трём направлениям и 
высота над платой).



⦿ Последнее, что необходимо знать при работе 
с трёхмерными деталями, это настройки 
отображения и цвет примитивов в режиме 
3D. Эти настройки устанавливаются в окне  
View Configuration, которое вызывается 
нажатием клавиши L. В появившемся окне 
можно выбрать один из готовых вариантов 
отображения платы в режиме 3D, 
приближенный к реальному виду. Также 
можно установить прозрачность для  Core – 
подложки платы, Top (Bottom) Silkscreen –
шелкографии на верхнем (нижнем) слое 
платы, Top (Bottom) Solder Mask – защитной 
маски на верхнем (нижнем) слое.





⦿ После установки ссылки на модель STEP, 
разработчик может вести работу с платой и с 
моделью в MCAD по отдельности. Для 
внесения изменений из  Altium Designer в 
сборку модели, необходимо выполнять 
сохранение платы в формате STEP 214 
(стандартной командой File Save As). Если 
изменения были сделаны в исходной модели 
STEP, то при запуске  Altium Designer будет 
предложено выполнить обновление модели и 
в редакторе плат. Однако стоит помнить, что 
Altium Designer проверяет обновление только 
тех моделей, которые находятся в папке, на 
которую имеется ссылка в настройках DXP > 
Preferences > PCB Editor > Models.



⦿ Подключение 3D моделей 
корпусов элементов (на 

примере резистора)



⦿ Использование трёхмерных моделей для 
отображения корпусов компонентов является 
более востребованным. На примере 
резистора рассмотрим подход к 
формированию библиотечного элемента, 
содержащего трёхмерную модель.

⦿ В программе Altium Designer имеется 
возможность создания библиотеки 
трёхмерных моделей  *.PCB3Dlib, однако 
следует отметить, что такие библиотеки 
унаследованы из ранних версий программы. 
Сейчас модель компонента, ранее созданную 
в любой из САПР твердотельного 
моделирования и сохраненную в формате 
STEP, можно добавить к посадочному месту 
напрямую. Рассмотрим данную возможность 
на примере резистора.



⦿ После создания посадочного места для 
резистора к нему можно добавить 
трёхмерную модель, которая на плате будет 
закреплена за посадочным местом. Для этого 
в библиотеке посадочных мест выполним 
команду Place >3D Body. В появившемся окне 
выберем тип модели Generic STEP Model и 
нажмём появившуюся кнопку Embed STEP 
Model. Нам предложат указать файл модели 
резистора в формате STEP. После нажатия 
кнопки ОК к курсору будет привязан розовый 
контур с заливкой в виде сетки (если работа 
ведётся в 2Dрежиме), который представляет 
собой проекцию модели на плату. Разместим 
этот контур в произвольном месте, после 
чего откажемся от размещения следующей 
модели нажатием кнопки Cancel.



Совместим установленную модель 
(отображаемую пока в виде 
проекции) с посадочным местом, 
что удобнее сделать в режиме 
трёхмерного просмотра (нажимаем 
клавишу 3).

При включении режима 3D на экране появится модель 
резистора; если этого не произошло, значит, либо 
отключен просмотр моделей, либо компонент расположен 
за пределами видимой области. Нажимаем 
последовательно клавиши V > F (масштабировать объекты 
во весь экран) и клавишу L для отображения настроек 
просмотра. Включаем отображение моделей в группе 3D 
Bodies



⦿ Теперь необходимо выполнить несколько 
операций по привязке модели и посадочного 
места. В нашем случае достаточно совместить 
выводы резистора с контактными 
площадками. В общем случае может 
потребоваться сложный набор действий по 
привязке модели; это зависит от того, как 
была создана модель в MCAD. Рекомендуется 
при формировании модели в исходной САПР 
базировать первый вывод модели в начале 
координат и ориентировать модель 
относительно плоскости XY (предполагая, что 
эта плоскость соответствует плате).



⦿ Для выравнивания модели относительно 
платы или заданной графики используется 
группа команд  Tools >3D Body Placement 
(доступны только в трёхмерном режиме). 
Вращение изображения осуществляется ПКМ 
с нажатой кнопкой Shift. Развернём 
компонент обратной стороной и выполним 
команду  Tools > 3D Body Placement > Position 
3D Body, позволяющую совместить модель и 
графику по одной точке.



⦿ После запуска команды 
курсор принимает вид 
маленького крестика, 
которым необходимо 
выбрать модель резистора. 
После этого курсор 
принимает вид большого 
креста (голубого цвета), 
который двигается по 
невидимым узлам модели. 
Выберем этим курсором 
центр первого вывода 
резистора (слева на рисунке 
9), после чего курсор 
становится синим 
прицелом. Перемещаем 
курсор в центр первой 
контактной площадки; 
изменение его цвета на 
зелёный (справа на рисунке 
9) говорит о попадании в 
привязку (Electrical Grid). 
Фиксируем положение 
резистора. Теперь резистор 
совмещён с посадочным 
местом 


